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NetWare Navigator Overview
NetWare Navigator is a tool you can use to distribute software packages to users on a Novell network.

NetWare Navigator components
NetWare Navigator has the following components:

Admin Distribution      Staging                Clients
Console Server         Servers

How distributions work
First, you create a package. This involves creating a contents list and, optionally, a script.
Next, you create a distribution list and schedule the distribution job. The flow of the job follows the arrows 
shown in the above diagram.



File
"New Package" lets you create a package. Once created, the package is added to the "Packages" 

list.

"Open Package" opens the package selected from the "Packages" list.

"Delete Package" lets you delete the package selected from the "Packages" list.

"Cancel Job" lets you access the "Cancel Job" dialog box and cancel the distribution job selected in 
the "Job ID" list of the "Cancel Job" dialog box.

"Exit" closes the Administration Console.



Editors
"Contents Lists" opens the Contents List Editor, allowing you to create and edit contents lists.

"Scripts" opens the Script Editor, allowing you to create and edit scripts.

"Distribution Lists" opens the Distribution List Editor, allowing you to create and edit distribution lists.



Status
"Active Jobs" displays a list of the distribution jobs that are still active in the system. The list provides 

status information on each job.

"Completed Jobs" displays a list of distribution jobs that were completed during the past several days.
The list provides status information on each job. The number of days jobs are kept in the list 
depends on a parameter you can set from the NetWare Navigator Setup program.

"Problem Jobs" displays a list of the active and completed distribution jobs that encountered 
problems. The list provides status information on each job.

"Node Status" displays a list of the nodes (Staging Servers and clients) targeted by the active and 
completed distribution jobs. This lets you look up job status information by node.



Help
"Contents" displays a table of contents for this Help system.

"Glossary" displays a glossary for this Help system.

"Search" displays a search dialog for this Help system.

"About NetWare Navigator" displays NetWare Navigator version and copyright information.



Packages
Lists the available packages.
Initially, the list includes some prebuilt Novell packages.You can use these packages if your organization 
has purchased the corresponding products.



Distribution Lists
Lists the available distribution lists.



Schedule Distribution
Lets you schedule the package selected from the "Packages" list for distribution to the distribution list 
selected from "Distribution Lists."
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Creating a Contents List
Creating a contents list makes it available to associate with one or more packages.

To create a contents list
1. From the "Editors" menu, choose "Contents Lists."

The Contents List Editor appears.
2. If the displayed contents list is untitled, skip to the next step. Otherwise, choose "New" from the "File" 

menu.
The "Contents List Files" list is cleared.

3. Add the desired contents list entries.
For help in the Contents List Editor, choose "Help."

4. Choose "OK."



Modifying a Contents List
1. From the "Editors" menu, choose "Contents Lists."

The Contents List Editor appears.
2. If the desired contents list is displayed, skip to the next step. Otherwise, choose "Open" from the 

"File" menu and open the desired contents list.
The contents list appears in the "Contents List Files" list.

3. Add and delete contents list entries as desired.
For help in the Contents List Editor, choose "Help."

4. Choose "OK."



Associating a Contents List with a Package
To specify the contents of a package, you must associate a contents list with the package.

To associate a contents list with a package
1. If the contents list doesn't exist, create it.
2. From the "Packages" list, choose the package.

The "Package Information" dialog appears.
3. In the "Contents List Name" field, enter the contents list name.
4. Choose "OK."



Deleting a Contents List
Deleting a contents list does not delete the actual files named in the contents list. It can, however, affect 
more than one package if the contents list is associated with multiple packages.

To delete a contents list
1. From the "Editors" menu, choose "Contents Lists."

The Contents List Editor appears.
2. If the desired contents list is displayed, skip to the next step. Otherwise, choose "Open" from the 

"File" menu and open the contents list.
The contents list appears in the "Contents List Files" list.

3. From the "File" menu, choose "Delete."
A confirmation dialog appears.

4. Choose "Yes."



Scheduling a Distribution Job
You can schedule distribution jobs from the existing packages and distribution lists.

To schedule a distribution job
1. From the "Packages" list, select the package to distribute.
2. From the "Distribution Lists" list, select the target distribution list.
3. Choose "Schedule Distribution."

The "Package Distribution" dialog appears.
4. Fill in the dialog.

For help in the dialog, choose "Help."
5. Choose "OK."



Checking a Distribution Job
Once you have scheduled a distribution job, you can check its status at any time.

To see if a job has problems
From the "Status" menu, choose "Problem Jobs."
The "Problem Jobs" list appears.
For help in the list, choose "Help."

To see if a job is done
From the "Status" menu, choose "Completed Jobs."
The "Completed Jobs" list appears.
For help in the list, choose "Help."

To check the status of a node in the distribution list
1. From the "Status" menu, choose "Node Status."

The "Node Status" list appears.
2. From the "Servers" or "Clients" list, select the node.
3. Choose "Details."

The "Node Status Details" list appears.
For help in the list, choose "Help."



Creating a Distribution List
Creating a distribution list adds it to the "Distribution Lists" list, making it available as a target for 
distributions.

To create a distribution list
1. From the "Editors" menu, choose "Distribution Lists."

The Distribution List Editor appears.
2. If an existing distribution list is displayed, choose "New" from the "File" menu.

The "Selected Servers" list and the "Clients" list are cleared.
3. Add distribution list entries as desired.

For help in the Distribution List Editor, choose "Help."
4. Choose "OK."



Modifying a Distribution List
1. From the "Distribution Lists" list, choose the distribution list.

The Distribution List Editor appears.
2. Add and delete distribution list entries as desired.

For help in the Distribution List Editor, choose "Help."
3. Choose "OK."



Deleting a Distribution List

If you are in the main Administration Console screen
1. From the "Distribution Lists" list, select the distribution list you want to delete.
2. Press <Delete.>

A confirmation dialog appears.
3. Choose "OK."

If you are in the Distribution List Editor
1. If the distribution list you want to delete is displayed, skip to the next step. Otherwise, choose "Open" 

from the "File" menu and open the distribution list.
The distribution list appears in the Distribution List Editor.

2. From the "File" menu, choose "Delete."
A confirmation dialog appears.

3. Choose "OK."



Using Keystroke Files
A script can include commands to play back keystroke files.
Use the DOS Client software to create a DOS keystroke file. Use the MS Windows Recorder to create a 
Windows keystroke file. A sample DOS keystroke file named WORDPNX.KSF is available in SYS:NETNAV\
PACKAGES on the Distribution Server.
For more information, see "Keystroke Robotics Operations" in Chapter 5 of the NetWare Navigator 
Administration Guide.



Modifying Your NetWare Navigator Setup
You can modify various aspects of your NetWare Navigator setup. You can
- Modify distribution timeout and retry parameters
- Install additional Staging Servers and clients
- Remove Staging Servers and clients
- Modify the Administration Console username and password
- Update your Administration Console drive mapping

To modify your NetWare Navigator setup
1. Close the Administration Console.
2. From the MS Windows Program Manager, go to the group containing the NetWare Navigator Setup 

program and choose the icon for the Setup program.
The main Setup screen appears.

3. From the "Help" menu, choose "Contents."
4. Choose "Modifying Your NetWare Navigator Setup."
5. Choose the procedure for your specific task.



Scheduling a NetWare Server Upgrade Job
For terms mentioned in this procedure, refer to your NetWare 4.01 documentation.
Overview

To schedule a NetWare Server Upgrade job
1. From the "Packages" list, select "NetWare Server Upgrade 4.01."
2. From the "Distribution Lists" list, select the target distribution list.

If the distribution list doesn't exist, you must create it.
If you are upgrading to a Single Reference Server, the distribution list should contain a single entry for the target server.
If you are upgrading to Secondary Servers, the distribution list should contain entries for each target server.

3. Choose "Schedule Distribution."
The "Package Distribution" dialog appears.

4. Under "Distribution Time," select the time to begin the distribution.
"Distribution Method" has no effect on a NetWare Server Upgrade job.

5. Choose "OK."
The "NetWare Upgrade Information" dialog appears.

6. Fill in the dialog.
For help in the dialog, choose "Help."

7. Choose "OK."



NetWare Server Upgrade Overview
What you can upgrade
How to break up the job
What happens during an upgrade
Required system configuration
Required time



Server Upgrade: What You Can Upgrade
You can upgrade Staging Servers from NetWare 3.11 to NetWare 4.01 by distributing the prebuilt 
"NetWare Server Upgrade 4.01" package.
You cannot upgrade the Distribution Server using this procedure.



Server Upgrade: How to Break up the Job
You should break the server upgrade process into separate distribution jobs.
- In the first job, upgrade the server that is to become the Single Reference Server (the one that 

supplies time to the other servers).
- In subsequent jobs, upgrade the servers that are to become Secondary Servers. Servers that are to 

be in the same level of the Directory tree can be upgraded in the same job.



Server Upgrade: What Happens during the Job
The upgrade process occurs in two phases:
- Phase I
- Phase II



Phase I
In this phase, server conditions are verified and users are given a three-minute logout warning. After 
users are disconnected and login disabled, the NetWare 4.01 files are decompressed into their proper 
directory structure.
Next, the server is set up to reboot as a 4.01 bindery-based server with the Phase II software loaded. 
Before rebooting, a connection is temporarily established with the Distribution Server to return feedback. 
At this point, you can view a feedback message and a Phase I log file from the Administration Console.



Phase II
This phase begins after the Phase I software reboots the server.
User login is immediately disabled and the NetWare 4.01 installation program is run using the parameters
you specified in the "NetWare Upgrade Information" dialog (see the steps of the procedure). This converts
the server to use NetWare Directory Services instead of the bindery.
After the installation program finishes, server configuration files are updated to reflect the new conditions, 
and user login is enabled.
At this point, assuming the upgrade to NetWare Directory Services was successful, feedback on Phase II 
is available at the Administration Console. (Two log files are appended to the Phase I log file -- one 
created by the NetWare installation program, and another created by the Phase II software.)
If the upgrade to NetWare Directory Services encountered errors that made the server unable to return 
feedback to the Distribution Server, no Phase II feedback will be available at the Administration Console, 
even though the job is finished.



Server Upgrade: Required System Configuration
- The NetWare 4.01 files must be in their original directory structure on a CD ROM disk or hard disk 

that is accessible to the Administration Console.
- The Distribution Server and each target Staging Server must have approximately 60 MB of free disk 

space.
- Each target Staging Server must be running NetWare 3.11.
- You should back up each target Staging Server before proceeding with the upgrade.
- Each target Staging Server must have DOS in memory (no REMOVE DOS command should have 

been issued).
- Each target Staging Server must be set up to load its LAN drivers from SYS:SYSTEM.
- Each target Staging Server must be set up to boot from a local DOS partition (not from a remote or 

network drive)
- Each target Staging Server must have the following commands in its AUTOEXEC.BAT file on the 

server boot partition:
CD <dir where SERVER.EXE is>
SERVER



Server Upgrade: Required Time
- The transfer of the upgrade package to the Distribution Server takes from one to two hours.

This process occupies the foreground of your workstation as soon as you schedule the job.
- The transfer of the upgrade package from the Distribution Server to the Staging Servers takes from 

one to two hours per Staging Server.
This process is serial and begins at the scheduled distribution time or once the preceeding step is done, whichever is later.

- The actual server upgrade can take anywhere from a few minutes to several hours, depending on 
how many volumes and Bindery objects the server has.
This process begins on each Staging Server as soon as the package is received.



Checking a NetWare Server Upgrade Job
Once a NetWare Server Upgrade job has been scheduled, you can check its status just as you would any
other distribution job.
However, when the upgrade package is received at the target Staging Servers and the server upgrade 
process begins, there are some unique factors that can affect how you
- Determine if problems occurred
- Correct problems



Determining If Server Upgrade Problems Occurred
Normally, when a distribution job encounters a problem, feedback is available from the Administration 
Console.
In the case of a server upgrade job, however, a server's ability to return feedback depends on whether the
upgrade job left the server in a condition to communicate on the network.

To determine if problems occurred
1. Check job status to see if Phase I was successful.

Make corrections and retry the job until Phase I succeeds.
2. Based on a reasonable time requirement for the server, wait until you think Phase II should be done.
3. Check job status. If no Phase II feedback appears, you can assume that problems have occurred.



Correcting Server Upgrade Problems
If you determine that a problem occurred during a server upgrade job, you can go to the server to correct 
the problem.

To correct a server upgrade problem
1. Check the error messages displayed on the NetWare server console.

If necessary, switch to the NLM screen.
Besides being written to disk, the log files generated during Phase II are also written to the screen. The last error messages 
displayed on the screen may reveal the problem.
Some error messages include an error code that provides further detail.

2. Try one of the following:
2a. Reboot using a NetWare 3.11 boot diskette and read the upgrade log file.

The log file is UPLOG.DAT, located in SYS:NETNAV\CONTROL\UPGRADE.
2b. Reboot using a NetWare 4.01 boot diskette. Load the 4.01 installation program and 

"manually" upgrade the server (enter inputs as prompted by the installation program).



Creating a Package
Creating a package adds it to the "Packages" list.

To create a package
1. From the "File" menu, choose "New Package."

The "Package Information" dialog appears.
2. Fill in the dialog.

For help in the dialog, choose "Help."
3. Choose "OK."



Modifying a Package
1. From the "Packages" list, choose the package.

The "Package Information" dialog appears.
2. Edit the information in the dialog as desired.

For help in the dialog, choose "Help."
3. Choose "OK."



Distributing a Package
You can distribute any package that has a contents list associated with it.

To distribute a package
1. If the desired distribution list doesn't exist, create it.
2. Schedule the distribution job.



Deleting a Package
1. From the "Packages" list, select the package.
2. From the "File" menu, choose "Delete Package."

The "Delete Package" dialog appears.
3. (Optional) Under "Delete Associated Files," select the associated files to delete.

For help in the dialog, choose "Help."
4. Choose "OK."



Creating a Script
Creating a script makes it available to associate with one or more packages.
Note: For guidelines on coding scripts, see "Creating Package Scripts" in Chapter 3 of the NetWare Navigator Administration Guide.

To create a script
1. From the "Editors" menu, choose "Scripts."

The Script Editor appears.
2. If the desired script is displayed, skip to the next step. Otherwise, choose "New" from the "File" menu.

The "Script" box is cleared.
3. Insert script commands in the script as desired.

For help in the Script Editor, choose "Help."
4. Choose "OK."



Modifying a Script
1. From the "Editors" menu, choose "Scripts."

The Script Editor appears.
2. If the desired script is displayed, skip to the next step. Otherwise, choose "Open" from the "File" menu

and open the script.
The script appears in the "Script" box.

3. Edit the script as desired.
For help in the Script Editor, choose "Help."

4. Choose "OK."



Associating a Script with a Package
If you want a package to include its own installation procedure, you must associate a script with the 
package.

To associate a script with a package
1. If the script doesn't exist, create it.
2. From the "Packages" list, choose the package.

The "Package Information" dialog appears.
3. In the "Script Name" field, enter the script name.
4. Choose "OK."



Reviewing Script Execution Results
Once you have scheduled a distribution job and a script log has been generated on any of the nodes in 
the job, you can review script execution results.

To see if a script has problems
1. From the "Status" menu, choose "Problem Jobs."

The "Problem Jobs" list appears.
2. If the job with which the script is associated is listed, select it.

If the job isn't listed, the script hasn't had any problems so far.
3. Choose "Details."

The "Problem Job Details" list appears.
4. Scan the "Feedback Message" column for messages about script execution. If you find one and the 

"Status" field contains a nonzero code, the script has had problems on that node.
For help in the "Problem Job Details" list, choose "Help."

To see a script log for a problem node
1. Complete the procedure "To see if a script has had problems," explained above
2. Select the problem node.
3. Choose "Details."

The "Script Log" screen appears.
For help in the screen, choose "Help."

To see if a script is done executing on all nodes
From the "Status" menu, choose "Completed Jobs."
The "Completed Jobs" list appears.
If the job with which the script is associated is listed, script execution is done on all the nodes in the job.

To see a script log for a successful node
1. Complete the procedure "To see if a script is done executing on all nodes," explained above. If the job

with which the script is associated is done, skip to step 2. Otherwise, do the following:
1a. Choose "OK."

You are returned to the main Administration Console screen.
1b. From the "Status" menu, choose "Active Jobs."

The "Active Jobs" list appears. Proceed with the next step.
2. Select the job with which the script is associated.
3. Choose "Details."

A "Job Details" list appears.
4. Scan the "Feedback Message" column for messages about script execution. If you find one and the 

"Status" field contains a zero code, select the line. If you don't find one with a zero status code, there 
are no successful nodes in the job.

5. Choose "Details."
The "Script Log" screen appears.
For help in the screen, choose "Help."

To look up a script log by node
1. From the "Status" menu, choose "Node Status."

The "Node Status" list appears.
2. From the "Servers" or "Clients" list, select the node.
3. Choose "Details."

The "Node Status Details" list appears.
4. Select the job with which the script is associated.
5. If the "Details" button is grayed, no script log is available for the node. Otherwise, choose "Details."

The "Script Log" screen appears.
For help in the screen, choose "Help."





Deleting a Script
Deleting a script can affect more than one package if the script is associated with multiple packages.

To delete a script
1. From the "Editors" menu, choose "Scripts."

The Script Editor appears.
2. If the desired script is displayed, skip to the next step. Otherwise, choose "Open" from the "File" menu

and open the script.
The script appears in the "Script" box.

3. From the "File" menu, choose "Delete."
A comfirmation dialog appears.

4. Choose "Yes."



Canceling a Distribution Job
A Distribution Job can be canceled after it is scheduled, but before it has begun distribution (that is, before
the scheduled time has been reached).
More than one Distribution Job can be canceled at the same time.

To cancel a Distribution Job
1. At the NetWare Navigator Administration Console, choose "Cancel Job..." from the "File" menu.    

The "Cancel Job" dialog box displays, listing all the jobs still in the queue and the time they are scheduled to begin distribution.
2. Select one or more jobs from the list and select "OK."    (To select more than one job, press and hold 

the <Shift> key while using the mouse to select the jobs in the list.) 
The "Confirm" pop-up box displays the following message: "Do you want to cancel the selected distribution jobs?"

3. Select "Yes" to cancel the jobs.    
The "Cancel Job" dialog box closes, returning you to the NetWare Navigator Administration Console main display.    
Note:    If a job has begun distribution since the "Cancel Job" dialog was displayed, it cannot be canceled, and you receive an 
error message.
Note:    If you select "No", the jobs are not canceled and the "Cancel Job" dialog box closes.    If you select "Cancel" the jobs 
are not canceled, but you remain at the Cancel Job" dialog box so you can select other jobs.
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Contents List Editor Overview
The Contents List Editor lets you work with contents lists. The screen title specifies which contents list is 
currently open.
You can add and delete entries in the current contents list. Each entry corresponds to a file with its 
distribution source and destination information.
If you don't explicitly specify distribution information when you add an entry to the contents list, the 
defaults displayed in the Contents List Editor are used. The default for "Target Directory" is the receive 
path.



Adding Contents List Entries
You can add entries one at a time, or you can add several entries at the same time. If you add several 
entries at the same time, each entry has the same source and destination information.

To add one or more entries
1. From the "Source Directories" list, choose the directory that contains the files you want to add.

The directory contents are displayed in the "Source Files" list.
2. From the "Source Files" list, select the files you want to add.
3. Use the Include Source Drive Letter, File Disposition, and Target Directory regions to specify 

distribution source and destination information for the selected files, or accept the defaults.
4. Choose "Add."



Removing Contents List Entries
1. From the "Contents List Files" list, select the entries you want to remove.
2. Choose "Remove."



File
"New" clears the "Contents List Files" list, allowing you to create a new contents list. If there are 

unsaved changes in the old contents list, you are prompted to save them.
Note: When you create a new contents list, the contents list is not associated with any package.

"Open" lets you open a different contents list. If there are unsaved changes in the old contents list, 
you are prompted to save them.

"Save" saves the current contents list. If the contents list is untitled, you are prompted to name it.

"Save As" lets you save the current contents list under a name you specify.

"Delete" lets you delete the current contents list. Deleting a contents list does not delete the actual 
files named in the contents list. It can, however, affect more than one package if the contents list 
is associated with multiple packages.



Contents List Files
Lists the files in the current contents list.



Add
Adds contents list entries.



Remove
Removes contents list entries.



Include Source Drive Letter
Specifies that the files being added to the contents list are to include the source drive letter.
Typically, you should leave this option selected. If you deselect it, the source files are assumed to reside 
on the Distribution Server in SYS:NETNAV\PACKAGES\<dir>, where <dir> is a subdirectory named 
after the package information (.JCF) file.
The option to leave out the source drive is provided primarily to allow third-party software developers to 
create prebuilt NetWare Navigator packages that have no dependency on a particular Distribution Server 
drive mapping.



Source Files
Lets you select files to add to the contents list.



Source Directories
Lets you choose the directory to display in the "Source Files" list.



File Disposition
Lets you indicate whether the files being added to the contents list should replace existing files of the 
same names in the target directory during distribution.



Filename
Specifies either a filename to add to the contents list or a filter for the "Source Files" list.
The field acts as a filter if you use wildcard characters.



Target Directory
The distribution destination for the files being added to the contents list.
Type in a drive and path. If you leave the field blank, the receive path is assumed. If you omit the drive, 
the drive of the receive path is assumed. If you specify a path that doesn't exist, the path is created during
distribution.



Current Directory
Specifies the name of the directory currently displayed in the "Source Files" list.



OK
Saves the contents list and closes the Contents List Editor.



Cancel
Closes the Contents List Editor without saving the contents list.
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Script Editor Overview
The Script Editor lets you work with scripts. The screen title specifies which script is open.
Creating and editing a script involves inserting either DOS or OS/2 script commands in the script, 
depending on which type of client the script is for. You should not insert both kinds of commands in the 
same script.
If you know the syntax of the script language, you can type commands directly into the "Script" box. 
Otherwise, you can use the command dialogs that are accessible from the "Commands" list.
This Help system describes all of the command dialogs but doesn't discuss guidelines for script coding. 
For those guidelines, see "Creating Package Scripts" in Chapter 3 of the NetWare Navigator 
Administration Guide.

Related topics
Using keystroke files



Inserting a Script Command
1. From the "Commands" list, choose the command.

A command dialog appears.
2. Fill in the dialog as desired.

For help in the dialog, choose "Help."
3. Choose "OK."



Switching between DOS and OS/2 Scripts
You can switch the contents of the "Commands" list between DOS and OS/2 script commands, depending
on the type of script you want to create.

To switch the script command set
From the "Target" menu, choose the new script type, "DOS" or "OS/2."
The "Script" box is cleared and the "Commands" list is updated with the new command set.
If there are unsaved changes in the old scirpt, you are prompted to save them.



Editing in the Script Box
In the "Script" box you can edit text like you do in Windows text editors, with the following note of caution.
Caution: Do not press <Enter> to insert a new line; press instead <Ctl><Enter.>
For other editing functions, use the Edit and Insert menus.



Using Sample Scripts
Sample scripts are provided for DOS, Windows, and OS/2. You can use a sample script as the basis for 
creating your own script.

To use a sample script
1. From the "File" menu, choose "Open."

The "Open Script" dialog appears.
2. From the "Scripts" list, select the sample script.

Select either DOSAPP1, WINAPP1, or OS2APP1, depending on the type of client the script will be for.
3. Choose "OK."

The sample script appears in the "Script" box.
4. Edit the script as desired.

When you are done editing the script, you can save it under a different name.



File
"New" clears the "Script" box, allowing you to create a new script. If there are unsaved changes in the

old script, you are prompted to save them.
Note: When you create a new script, the script is not associated with any package.

"Open" lets you open a different script. If there are unsaved changes in the old script, you are 
prompted to save them.

"Save" saves the current script. If the script is untitled, you are prompted to name it.

"Save As" lets you save the current script under a name you specify.

"Delete" lets you delete the current script. Deleting a script can affect more than one package if the 
script is associated with multiple packages.



Edit
"Undo" reverses the last editing function you performed in the "Script" box.

"Cut" deletes the selected text from the "Script" box and copies it to the MS Windows Clipboard.

"Copy" copies the selected text from the "Script" box to the MS Windows Clipboard.

"Paste" inserts the contents of the MS Windows Clipboard at the current insertion point in the "Script" 
box.

"Delete" deletes the selected text from the "Script" box.



Insert
"New Line" inserts a new line character (carriage return) at the current insertion point in the "Script" 

box.

"Tab" inserts a tab character at the current insertion point in the "Script" box.



Target
Lets you switch the Script Editor between DOS and OS/2 script commands, depending on the type of 
script you want to create.

"DOS" clears the "Script" box and displays the DOS and Windows script commands in the 
"Commands" list. If there are unsaved changes in the old OS/2 script, you are prompted to save 
them.

"OS/2" clears the "Script" box and displays the OS/2 script commands in the "Commands" list. If there
are unsaved changes in the old DOS script, you are prompted to save them.



Commands
Lists the available script commands.
- If    "DOS Targets" is specified in the parentheses above the list, the DOS and Windows script 

commands are listed.
- If "OS/2 Targets" is specified in the parentheses above the list, the OS/2 script commands are listed.



Script
Displays the current script.



OK
Saves the script and closes the Script Editor.



Cancel
Closes the Script Editor without saving the script.
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Distribution List Editor Overview
The Distribution List Editor lets you work with distribution lists. The screen title specifies which distribution 
list is open.
Each entry in a distribution list corresponds to a Staging Server, client, DOS LAN Distributor server, or 
DOS LAN Distributor client.



Adding Distribution List Entries

To add a server
1. From the "Available Servers" list, select the server.
2. Choose "Add."
To add all available servers
From the "Add" menu, choose "All Servers."

To add one or more clients
1. From the "Available Servers" list, select a server.
2. From the lower "Clients" list, select the clients.
3. Choose "Add."
4. Repeat steps 1 to 3 for other servers until done.

To add all clients of a server
1. From the "Available Servers" list, select the server.
2. From the "Add" menu, choose "All Clients."



Removing Distribution List Entries
1. From the "Selected Servers" list, select a server.
2. (Optional) From the upper "Clients" list, select one or more clients.
3. Choose "Remove."

If you selected clients, only the clients are removed. Otherwise, the server and all of its clients are removed.



File
"New" clears the "Selected Servers" list and the upper "Clients" list, allowing you to create a new 

distribution list. If there are unsaved changes in the old distribution list, you are prompted to save 
them.

"Open" lets you open a different distribution list. If there are unsaved changes in the old distribution 
list, you are prompted to save them.

"Save" saves the current distribution list. If the distribution list is untitled, you are prompted to name it.

"Save As" lets you save the current distribution list under a name you specify.

"Delete" lets you delete the current distribution list.



Add
"All Clients" adds the current contents of the lower "Clients" list to the distribution list.

"All Servers" adds all available servers to the distribution list.



Search
"Selected Servers List" lets you search the "Selected Servers" list.

"Selected Clients List" lets you search the upper "Clients" list.

"Available Servers Database" lets you search the "Available Servers" list.

"Available Clients Database" lets you search the lower "Clients" list.

In the search dialog that appears, enter a search string with no wildcard characters and choose "OK." If 
the string is found, the appropriate entry in the list is highlighted.



Selected Servers
Lists the servers in the current distribution list.
If both a server and one or more of its clients are in the distribution list, only the clients are actual 
distribution targets.



Clients (upper list)
Lists clients in the current distribution list.
To see other clients in the list, select a different server in the "Selected Servers" list.



Add
Adds distribution list entries.



Remove
Removes distribution list entries.



Available Servers
Lists the servers you can add to the distribution list.
The list contains all the servers you installed as Staging Servers or identified as DOS LAN Distributors 
using the NetWare Navigator Setup program.



Clients (lower list)
Lists the clients you can add to the distribution list for the selected server.
To see other available clients, select a different server in the "Available Servers" list.



OK
Saves the distribution list and closes the Distribution List Editor.



Cancel
Closes the Distribution List Editor without saving the distribution list.



Active Jobs
Lists the active jobs in the system.
As jobs finish or time out, they are deleted from the list.

Regions and buttons
Distrib Time
Package
Distrib List
Node Status
Details
Print
OK

Related topics
Pull
Push



Distrib Time
The job's scheduled distribution time.



Package
The name of the package being distributed.



Distrib List
The name of the distribution list for the job.



Node Status
Shows the progress of the job in terms of the nodes in the distribution list.

"Success" shows the number of successful nodes so far.
A node is considered successful when script execution is successful, if the package has a script. Otherwise, a node is 
considered successful when the package is received at the node ("push" distribution) or received at the node's Staging 
Server ("pull" distribution).

"Failed" is the number of failed nodes so far.

"Total" is the total number of nodes in the distribution list.

When "Success" and "Failed" add up to "Total," the job is complete and is deleted from the list.



OK
Closes the "Active Jobs" list.



Details
Opens a list of the nodes in the selected job, and displays the current status of each node.



Print
Prints the list of active jobs.
The printout is sent to your default Windows printer.



Active Job Details
Lists the nodes in an active job and displays the current status of each node.
The screen title specifies which package is being reported on.

Regions and buttons
Distrib Time
Node
Feedback Message
Status
Details
Print
OK

Related topics
Status codes
Script log



Distrib Time
The job's scheduled distribution time.



Node
The node being reported on.



Feedback Message
A message that reports the current status of the job on the node.



Status
A status code that specifies the reason for the current status.
A zero code indicates success.



OK
Closes the "Active Job Details" list.



Details
Opens a script log if one exists for the selected node.



Print
Prints the node status list.
The printout is sent to your default Windows printer.



Script Log
Displays the script log for a node in a job.
The contents of the script log are determined by how the script is coded.
The screen title specifies which script log is open.

Buttons
Print
OK



OK
Closes the "Script Log" screen.



Print
Prints the script log.
The printout is sent to your default Windows printer.



Completed Jobs
Lists the completed jobs.
Jobs remain in the list until they time out. You can change the completed job timeout using the NetWare 
Navigator Setup program.

Regions and buttons
Distrib Time
Package
Distrib List
Node Status
Details
Print
OK

Related topics
Pull
Push



Distrib Time
The job's scheduled distribution time.



Package
The name of the package that was distributed.



Distrib List
The name of the distribution list for the job.



Node Status
Shows the results of the job in terms of the nodes in the distribution list.

"Success" is the number of successful nodes.
A node is considered successful when script execution is successful, if the package has a script. Otherwise, a node is 
considered successful when the package is received at the node ("push" distribution) or received at the node's Staging 
Server ("pull" distribution).

"Failed" is the number of nodes that were retried the maximum amount of time without success.

"Total" is the total number of nodes in the distribution list. It is also the sum of "Success" and "Failed."



OK
Closes the "Completed Jobs" list.



Details
Opens a list of the nodes in the selected job, and displays the final status of each node.



Print
Prints the list of completed jobs.
The printout is sent to your default Windows printer.



Completed Job Details
Lists the nodes in a completed job and displays the final status of each node.
The screen title specifies which package is being reported on.

Regions and buttons
Distrib Time
Node
Feedback Message
Status
Details
Print
OK

Related topics
Status codes
Script log



Distrib Time
The job's scheduled distribution time.



Node
The node being reported on.



Feedback Message
A message that reports the final status of the job on the node.



Status
A status code that specifies the reason for the final status.
A zero code indicates success.



OK
Closes the "Completed Job Details" list.



Details
Opens a script log if one exists for the selected node.



Print
Prints the node status list.
The printout is sent to your default Windows printer.



Problem Jobs
Lists the problem jobs.
As jobs finish successfully or time out, they are deleted from the list.

Regions and buttons
Distrib Time
Package
Distrib List
Node Status
Details
Print
OK

Related topics
Pull
Push



Distrib Time
The job's scheduled distribution time.



Package
The name of the package that was (or is being) distributed.



Distrib List
The name of the distribution list for the job.



Node Status
Shows the progress of the job in terms of the nodes in the distribution list.

"Success" is the number of successful nodes so far.
A node is considered successful when script execution is successful, if the package has a script. Otherwise, a node is 
considered successful when the package is received at the node ("push" distribution) or received at the node's Staging 
Server ("pull" distribution).

"Failed" is the number of failed nodes so far.

"Total" is the total number of nodes in the distribution list.

If "Success" and "Failed" add up to "Total," the job is complete; otherwise it is still active.



OK
Closes the "Problem Jobs" list.



Details
Opens a list of the nodes in the selected job, and displays the status of each node.



Print
Prints the list of problem jobs.
The printout is sent to your default Windows printer.



Problem Job Details
Lists the nodes in a problem job and displays the status of each node.
The screen title specifies which package is being reported on.

Regions and buttons
Distrib Time
Node
Feedback Message
Status
Details
Print
OK

Related topics
Status codes
Script log



Distrib Time
The job's scheduled distribution time.



Node
The node being reported on.



Feedback Message
A message that reports the status of the job on the node.



Status
A status code that specifies the reason for the status.
A zero code indicates success.



OK
Closes the "Problem Job Details" list.



Details
Opens a script log if one exists for the selected node.



Print
Prints the node status list.
The printout is sent to your default Windows printer.



Node Status
Lists the nodes (Staging Servers and clients) targeted by the active and completed jobs.

Regions and buttons
Servers
Clients
Details
OK



Servers
Lists the Staging Servers targeted by the active and completed jobs.



Clients
Lists the clients targeted by the active and completed jobs.



OK
Closes the "Node Status" list.



Details
Opens a list of the active and completed jobs on the selected node, and displays the status of each job.



Node Status Details
Lists the active and completed jobs on a node, and displays the status of each job.
The screen title specifies the node being reported on.

Regions and buttons
Distrib Time
Package
Feedback Message
Status
Details
Print
OK

Related topics
Status codes
Script log



Distrib Time
The job's scheduled distribution time.



Package
The name of the package that was (or is being) distributed.



Feedback Message
A message that reports the status of the job.



Status
A status code that specifies the reason for the status.
A zero code indicates success.



OK
Closes the "Node Status Details" list.



Details
Opens a script log if one exists for the selected job.



Print
Prints the list of jobs.
The printout is sent to your default Windows printer.



Status Codes
Select the feedback message associated with your status code.

Distribution to Staging Server failed
Distribution to client failed
Script execution failed
NetWare Upgrade Phase x Failed



Status Codes for "Distribution to Staging Server failed"
62
4097
4098
4099
4100
4101
4102
4103
4104
4105



62

Explanation:
Target disk full -- file not transferred.

Action:
Free some space on the Staging Server's disk.



4097

Explanation:
Distribution retried maximum number of times.

Action:
Reschedule the distribution job.



4098

Explanation:
Could not transfer the .JCF file (file containing package information).

Action:
Reschedule the distribution job.



4099

Explanation:
Could not transfer the .SCF file (file containing package contents list).

Action:
Reschedule the distribution job.



4100

Explanation:
Failed to connect to Staging Server -- could not attempt distribution.

Action:
- Ensure that the NetWare server that is acting as the Staging Server is up.
- Ensure that the following NLMs are loaded on the Staging Server: TSA311 or TSA400, and SMD31x 

or SMDR.



4101

Explanation:
Failed to log in to Staging Server -- could not queue new job.

Action:
User NWSDSYS doesn't exist on the Staging Server. Reinstall the Staging Server.



4102

Explanation:
Failed to locate Staging Server input queue -- could not queue new job.

Action:
Staging Server queue doesn't exist. Reinstall the Staging Server.



4103

Explanation:
Could not create new job entry in Staging Server queue.

Action:
The needed queue rights don't exist. Reinstall the Staging Server.



4104

Explanation:
Could not get Staging Server to service new job in input queue.

Action:
Ensure that SJOBDMGR.NLM and SJOBFDBK.NLM are loaded on the Staging Server.



4105

Explanation:
Error in Storage Management System (file transfer module) -- could not distribute to Staging Server.

Action:
- Ensure that the following NLMs are loaded on the Staging Server: TSA311 or TSA400, and SMD31x 

or SMDR.
- If the above NLMs are loaded, the problem could be that user NWSDSYS doesn't exist on the 

Staging Server. In this case, reinstall the Staging Server.



Status Codes for "Distribution to client failed"
2
3
4
10
50
60
61
62
63
64
65



2

Explanation:
Error opening file -- distribution aborted.

Action:
- Ensure that the SJOBDMGR NLM running on the Staging Server is the one that was shipped with the

version of NetWare Navigator you are using.
- Verify that user NWSDSYS has supervisor rights on the Staging Server.



3

Explanation:
Error reading file -- distribution aborted.

Action:
- Ensure that the SJOBDMGR NLM running on the Staging Server is the one that was shipped with the

version of NetWare Navigator you are using.
- Verify that user NWSDSYS has supervisor rights on the Staging Server.
- Ensure that volume SYS: has all bad sectors marked.



4

Explanation:
Error writing file -- distribution aborted.

Action:
- Ensure that the SJOBDMGR NLM running on the Staging Server is the one that was shipped with the

version of NetWare Navigator you are using.
- Verify that user NWSDSYS has supervisor rights on the Staging Server.
- Ensure that volume SYS: of the Staging Server has all bad sectors marked.
- Ensure that volume SYS: of the Staging Server has sufficient disk space.



10

Explanation:
Distribution Server requested invalid action -- distribution to client not attempted.

Action:
Ensure that the SJOBDMGR NLM running on the Staging Server is the one that was shipped with the 
version of NetWare Navigator you are using.



50

Explanation:
Error in Storage Management System (file transfer module) -- could not distribute to client.

Action:
No action is required. Distribution will retry later.



60

Explanation:
Distribution to client terminated by user.

Action:
No action is required. Distribution will retry later.



61

Explanation:
Could not locate file to transfer.

Action:
- Ensure that the client's receive path exists.
- Ensure that the client has drive N: mapped to volume SYS: of the Staging Server.



62

Explanation:
Target disk full -- file not transferred.

Action:
Free some space on the client's disk.



63

Explanation:
File by same name exists and "No Replace" requested -- file transfer cancelled.

Action:
Remove or rename the file on the client. Distribution will retry later.



64

Explanation:
Disk access denied -- file not transferred.

Action:
Verify that the client has Read, Write, Create, and Delete rights to the directory SYS:NETNAV\SHARED.



65

Explanation:
Client workstation environment has insufficient file handles -- file not transferred.

Action:
Increase the FILES= line in client's CONFIG.SYS file.



Status Codes for "Script execution failed"
The codes returned from script execution are defined by the person who creates the script.
- For DOS or Windows scripts, the Exit script (%EXIT) command sets the code.
- For OS/2 scripts, the Script return code (NNSETRC) command sets the code.



Status Codes for "NetWare Upgrade Phase x Failed"
Any nonzero code represents a general failure. To get error details, you must view the log file associated 
with the job.

To view the log file
1. From the "Job Details" list in which the job is listed, select the desired node.
2. Choose "Details."

The "Script Log" screen is displayed. Some of the log messages include an error code that provides further detail.
Important: The "Details" button is grayed if the log file is not available on the Distribution Server. See Checking a NetWare 
Server Upgrade job for more information.



NetWare Server Upgrade Log Message Error Codes
4
6
10
27
28
29
30
31
32
33



4

Explanation:
Insufficient memory to complete task.

Action:
Install more memory on the server.



6

Explanation:
Internal function took too much time and was aborted.

Action:
The server upgrade is probably incomplete. If you get this error in Phase I, you can try rescheduling the 
job. If you get the error in Phase II, you must manually upgrade the server by running the 4.01 installation 
program.



10

Explanation:
Internal function was given invalid input.

Action:
This is a fatal error. Possible causes are insufficient server memory or insufficient disk space allocated to 
SYS:SYSTEM. You must manuallly upgrade the server by running the 4.01 installation program.



27

Explanation:
DOS has been unloaded from the server's memory.

Action:
1. Ensure that no REMOVE DOS command will be issued as part of the server's startup procedure. (If 

necessary, modify the AUTOEXEC.NCF file or other files that automatically run when the server is 
loaded.)

2. Down and reload the server.
3. Reschedule the server upgrade job.



28

Explanation:
Unable to copy NetWare or disk driver boot files.

Action:
This is a fatal error. A REMOVE DOS command may have been issued from the server. Try scheduling 
the server upgrade job again. If it fails on the second attempt, you must manually upgrade the server by 
running the 4.01 installation program.



29

Explanation:
Unable to open a file.

Action:
If the upgrade job was aborted due to this error, you must manually upgrade the server by running the 
4.01 installation program.
If you got this error but the upgrade job wasn't aborted as a result, try rescheduling the upgrade job once 
the initial job has finished.



30

Explanation:
Insufficient disk space to complete task.

Action:
Add more disk space to the server and reschedule the server upgrade job.



31

Explanation:
Attempt to obtain required disk space failed.

Action:
No action is required (the upgrade will continue). However, the upgrade will fail if there is insufficient disk 
space to upgrade the server.



32

Explanation:
Error copying on or more files.

Action:
If this error occurs while copying files to the server's DOS partition, the upgrade will most likely fail. In this 
case, you must manually complete the upgrade by running the 4.01 installation program.
If the error occurs while copying files elsewhere, try rescheduling the upgrade job.



33

Explanation:
Unable to convert script file into the format required by the NetWare 4.01 installation program.

Action:
The upgrade has been aborted because of insufficient disk space, a corrupt script file, or some other 
NetWare error that caused files to be inaccessible. You must manually complete the upgrade by running 
the 4.01 installation program.



Distribution Server Login
Lets you log in to the Distribution Server as the Administration Console user.
Use the NetWare Navigator Setup program to create the Administration Console user.

Regions and buttons
Username
Password
Cancel
OK



Username
Type in the Administration Console username.



Password
Type in the Administration Console password.
It won't show up as you type it.



OK
Logs you in to the Distribution Server and opens the Administration Console.



Cancel
Cancels opening of the Administration Console.



Package Information
Lets you edit a package.

Regions and buttons
Name
Version
Contents List Name
Contents Lists
Edit Contents List
Script Name
Scripts
Edit Script
Cancel
OK



Name
The package name. This is the only required information for a new package.



Version
An optional package version number that appears as part of the package name in the "Packages" list on 
the main screen.



Contents List Name
The name of the contents list associated with the package.
This field must contain the name of an existing contents list before you can distribute the package.



Contents Lists
Lets you select the name of an existing contents list to put in the "Contents List Name" field.



Edit Contents List
Opens the contents list specified in the "Contents List Name" field.
If the "Contents List Name" field is empty or specifies a contents list that doesn't exist yet, choosing this 
button opens a new contents list and associates it with the package.



Script Name
The name of the script associated with the package.



Scripts
Lets you select the name of an existing script to put in the "Script Name" field.



Edit Script
Opens the script specified in the "Script Name" field.
If the "Script Name" field is empty or specifies a script that doesn't exist yet, choosing this button opens a 
new script and associates it with the package.



OK
Saves the package and closes the dialog.
If the package is new, it is added to the "Packages" list on the main screen.



Cancel
Closes the dialog without saving the package.



Delete Package
Lets you delete a package.

Regions and buttons
Upper field
Delete Associated Files
Cancel
OK

Related topics
Script
Contents list



Upper field
Specifies the name of the package that is selected for deletion.



Delete Associated Files
Lets you select optional items to delete. If an item is grayed, it means the package does not have that 
item.

The first item is the package script.

The second item is the package contents list. Deleting a contents list does not delete the actual files 
named in the contents list. It can, however, affect more than one package if the contents list is 
associated with multiple packages.



OK
Performs the deletion.



Cancel
Cancels the deletion.



Open Contents List
Lets you choose a contents list to open.

Regions and buttons
Contents List Name
Contents Lists
Cancel
OK



Contents List Name
The name of the contents list to open.
Type in a name or select one from "Contents Lists."



Contents Lists
Lets you select the name of an existing contents list to put in the "Contents List Name" field.



OK
Opens the contents list.



Cancel
Closes the dialog without opening a contents list.



Save Contents List
Lets you save a contents list under a name you specify.

Regions and buttons
Contents List Name
Contents Lists
Cancel
OK



Contents List Name
The name for the contents list.
Type in a name, or, if you plan to overwrite an existing contents list, select the contents list from "Contents
Lists."



Contents Lists
Lets you select the name of an existing contents list to put in the "Contents List Name" field.
Warning: Use this list only if you want to overwrite an existing contents list. Double-clicking a contents list
overwrites it with the new contents list you are saving.



OK
Saves the contents list under the specified name.



Cancel
Closes the dialog without saving the contents list.



Open Script
Lets you choose a script to open.

Regions and buttons
Script Name
Scripts
Cancel
OK



Script Name
The name of the script to open.
Type in a name or select one from the "Scripts" box.



Scripts
Lets you select the name of an existing script to put in the "Script Name" field.



OK
Opens the script.



Cancel
Closes the dialog without opening a script.



Save Script
Lets you save the current script under a name you specify.

Regions and buttons
Script Name
Scripts
Cancel
OK



Script Name
The name for the new script.
Type in a name, or, if you plan to overwrite an existing script, select the script from the "Scripts" box.



Scripts
Lets you select the name of an existing script to put in the "Script Name" field.
Warning: Use this list only if you want to overwrite an existing script. Double-clicking a script overwrites it 
with the new script you are saving.



OK
Saves the new script under the specified name.



Cancel
Closes the dialog without saving the script.



Open Distribution List
Lets you choose a distribution list to open.

Regions and buttons
Distribution List Name
Distribution Lists
Cancel
OK



Distribution List Name
The name of the distribution list to open.
Type in a name or select one from "Distribution Lists."



Distribution Lists
Lets you select the name of an existing distribution list to put in the "Distribution List Name" field.



OK
Opens the distribution list.



Cancel
Closes the dialog without opening a distribution list.



Save Distribution List
Lets you save the current distribution list under a name you specify.

Regions and buttons
Distribution List Name
Distribution Lists
Cancel
OK



Distribution List Name
The name for the new distribution list.
Type in a name, or, if you plan to overwrite an existing distribution list, select the distribution list from 
"Distribution Lists."



Distribution Lists
Lets you select the name of an existing distribution list to put in the "Distribution List Name" field.
Warning: Use this list only if you want to overwrite an existing distribution list. Double-clicking a 
distribution list overwrites it with the new distribution list you are saving.



OK
Saves the new distribution list under the specified name.



Cancel
Closes the dialog without saving the distribution list.



Package Distribution
Lets you schedule a distribution job.

Regions and buttons
Distribute
To
Distribution Time
Distribution Method
Cancel
OK

Related topics
Pull
Push



Distribute
Specifies the name of the package that is selected for distribution.



To
Specifies the name of the distribution list that is selected to receive the distribution.



Distribution Time
Lets you specify the date and time distribution is to begin. (The default is the current date and time.)
Type or select the desired month, day, year, and time. You must use 24-hour time in the "Time" field.



Distribution Method
Lets you select the distribution method (Pull or Push).



OK
Schedules the distribution job.



Cancel
Closes the dialog without scheduling the distribution job.



NetWare Upgrade Information
Lets you specify information required for the NetWare Server Upgrade job.
If you aren't sure what to specify for these parameters, refer to your NetWare 4.01 documentation.

Regions and buttons
License Source Drive
NetWare Source Path
Company Name
DS Tree Name
Sub-Organization x (Optional)
Secondary Server
Single Reference Server
Single Ref Server Address
Admin Password
Time Zone
Daylight savings time?
Start Time
End Time
Cancel
OK

Related topics

Distributing the NetWare Server Upgrade package

Checking a NetWare Server Upgrade job



License Source Drive
The letter of the drive that will read the NetWare license diskettes.



NetWare Source Path
The path from which the NetWare upgrade files will be distributed.
The root of the path can be a CD-ROM drive or a hard disk drive.



Company Name
The name of an Organization object representing your company in the Directory tree.
Only alphanumeric characters and the underscore (_) are valid in this field.



DS Tree Name
The name of the Directory tree.
If you are installing the Single Reference Server, type in a name for the new tree.
If you are installing Secondary Servers, type in the tree name previously specified for the Single 
Seference Server.



Sub-Organization x (Optional)
The name of an Organizational Unit object under your company (such as a division or department).
If you are installing the Single Reference Server and you want to create an Organizational Unit, type in a 
name for the new Organizational Unit.
If you are installing Secondary Servers, you can type in the name of a new or existing Organizational Unit.



Secondary Server
Used if you have already installed the Single Reference Server and are now installing Secondary Servers.



Single Reference Server
Used if you are installing the Single Reference Server.
You must install the Single Reference Server before installing Secondary Servers (although you need not 
use NetWare Navigator to install the Single Reference Server).



Single Ref Server Address
The internal IPX address of the Single Reference Server that will supply time to the Secondary Servers 
you are installing.
This information is required only if you are installing Secondary Servers (the field is grayed if the "Single 
Reference Server" option is selected).



Admin Password
The NetWare server administrator password.
If you are installing the Single Reference Server, type in the new password.
If you are installing Secondary Servers, type in the password previously specified for the Single 
Reference Server.



Time Zone
Lets you select the time zone where the target servers reside.
If you are installing Secondary Servers, do not select a different time zone than that of the Single 
Reference Server unless you fully understand the implications of doing so. For more information, see the 
NetWare 4.01 Getting Started manual.



Daylight savings time?
Lets you indicate whether the servers you are installing will use daylight savings time.
If you select "No," the next two fields are grayed.



Start Time
Lets you select the month, day, and hour when daylight savings time starts.
If you select a day of the week (rather than a number) for "Day," you must also select "First" or "Last" to 
indicate which week of the month you mean.



End Time
Lets you select the month, day, and hour when daylight savings time ends.
If you select a day of the week (rather than a number) for "Day," you must also select "First" or "Last" to 
indicate which week of the month you mean.



OK
Saves the upgrade information and schedules the distribution job.



Cancel
Cancels the scheduling of the distribution job.



Cancel Job
Lets you cancel a distribution job that has not begun distribution; that is, a package that has been 
scheduled, but the scheduled distribution time has not been reached.    The distribution jobs displayed in 
this dialog box are jobs in the distribution job queue that are waiting to be distributed.
You may select more than one job to be cancelled at the same time.

Regions and buttons
Scheduled Time of Distribution
Job ID
Package
Distribution List
Cancel
OK



Scheduled Time of Distribution
The date and time the distribution job is scheduled to be distributed.



Job ID
The number used to identify the distribution job.



Package
The name of the set of files scheduled to be distributed as a unit; for example, an application upgrade 
package.    A package can include a script file that installs the package on client workstations.



Distribution List
The name of the group of nodes (clients or Staging Servers) to which the package is scheduled to be 
distributed.



Cancel
Cancels the "cancel job" operation.



OK
Performs the job cancellation.



DOS and Windows Script Commands
For detailed information on the command line format and return codes for these commands, see 
Appendix A of the NetWare Navigator Administration Guide.

Comments
Copy files
Delete files
Disk space
DOS commands
Edit group/icon (WIN)
Edit .INI (WIN)
Environment variable
Exit script
Go to
Go to, if error
If condition true
If directory exists
If file exists
Keystroke playback (DOS)
Label
Locate path of file
Log message
Occurrences of file
Rename files
Schedule edit (DOS)
Schedule edit (WIN)
Schedule reload (DOS)
Set file status
Start script
Warning window (WIN)



Comments (*)
Comments make your script more readable but are ignored during script execution.

Regions and buttons
Input field
Cancel
OK



Input field
Enter the text of your comment.



Cancel
Cancels the comment.



OK
Inserts the comment in the script.



Copy files (NNCPY)
NNCPY copies one or more files.

Regions and buttons
Source file
Destination file
Copy file if date is same or after this date
Copy file with archive bit set
Copy from subdirectories
Create empty subdirectories
Prompt user before each file copy
Verify file copy
Cancel
OK



Source file
The path and files to copy from.
Use a full path and wildcard characters as needed. If you omit the path, the current directory is assumed.



Destination file
The path and files to copy to.
Use a full path and wildcard characters as needed. If you omit the path, the current directory is assumed.



Copy file if date is same or after this date
(Optional) Specifies a date (MM/DD/YY) against which the source files should be compared before 
copying. If a source file is older than the date, it won't be copied.



Copy file with archive bit set
"Reset archive bit" inserts the /M command option, causing only files with the archive bit on to be 

copied. The archive bit is turned off during the copy.

"Do not reset archive bit" inserts the /A command option, causing only files with the archive bit on to 
be copied. The archive bit is not turned off during the copy.



Copy from subdirectories
Inserts the /S command option, causing all non-empty subdirectories and matching files to be copied.



Create empty subdirectories
Inserts the /E command option, causing all subdirectories (including empty ones) and matching files to be
copied.



Prompt user before each file copy
Inserts the /P command option, causing the user to be prompted to confirm each file copy before it is 
performed.



Verify file copy
Inserts the /V command option, causing the name of each file to be displayed on the workstation console 
as it is copied.



Cancel
Cancels the NNCPY command.



OK
Inserts the NNCPY command in the script.



Delete files (NNDEL)
NNDEL deletes one or more files.

Regions and buttons
File to delete
Prompt user for confirmation
Cancel
OK



File to delete
The files to delete.
Use a full path and wildcard characters as needed. If you omit the path, the current directory is assumed.



Prompt user for confirmation
Suppresses the /Q command option, causing the user to be prompted to confirm each file deletion.



Cancel
Cancels the NNDEL command.



OK
Inserts the NNDEL command in the script.



Disk space (NNSPC)
NNSPC checks the amount of free and used space on the disk containing the receive path. It performs 
other optional checking based on any input you provide in the dialog.

Regions and buttons
Calculate space used by this file
Directory path
Check for this amount of disk space
Do not display error messages
Cancel
OK



Calculate space used by this file
Inserts the /F command option, causing the amount of space occupied by the specified files to be 
calculated.
Use a full path and wildcard characters as needed. If you omit the path, the current directory is assumed.



Directory path
The directory path on which to perform the actions selected below. If you omit the path, the current 
directory is assumed.

"Calculate space used by this directory" inserts the /D command option, causing the amount of space
occupied by the specified directory to be calculated.

"Calculate space used by all subdirectories of this directory" causes the amount of space occupied by
all subdirectories of the specified directory to be calculated.



Check for this amount of disk space
Causes the specified amount of disk space to be verified.
Enter the desired amount and select kilobytes (K) or megabytes (M) from the drop down list.
Important: When you use this option, NNSPC returns a nonzero completion code if the specified amount 
of space is not available.



Do not display error messages
Inserts the /Q command option, suppressing screen output from NNSPC.



Cancel
Cancels the NNSPC command.



OK
Inserts the NNSPC command in the script.



DOS Commands
DOS commands perform various functions (see your DOS Reference for details).
Note: The CD (Change Directory) command is not supported.

Regions and buttons
Input field
Redirect output to script log
Cancel
OK

Related topics
Script log



Input field
Enter the desired DOS command. Type the command exactly as you would at the DOS prompt.



Redirect output to script log
Suppresses insertion of the %NORED command in front of the specified DOS command, causing screen 
output from the DOS command to be redirected to the script log.



Cancel
Cancels insertion of a DOS command.



OK
Inserts the DOS command in the script.



Edit group/icon (NNWIN ICON)
NNWIN ICON adds, removes, or replaces a program icon in the MS Windows Program Manager.

Regions and buttons
Application
Icon name
Group name
Add icon
Remove icon
Replace icon
Cancel
OK



Application
"Full path name" is the command line for the application.

"Parameters" (optional) are any parameters to add to the command line.

"Working directory" is the working directory for the application.



Icon name
The name of the program icon.



Group name
The name of the group containing the icon.



Add icon
Inserts the /A command option, causing the icon to be added to the group.
The group is created if it doesn't exist.



Remove icon
Inserts the /R command option, causing the icon to be removed from the group.
If you omit "Icon name," the group is removed.



Replace icon
Inserts the /P command option, causing the icon to replace an existing icon of the same name in the 
group. If no such icon exists, the icon is added to the group.



Cancel
Cancels the NNWIN ICON command.



OK
Inserts the NNWIN ICON command in the script.



Edit .INI (NNWIN INI)
NNWIN INI modifies an .INI file.

Regions and buttons
Section
Keyname
Value
Add key/value pair
Remove key/value pair
List key/value pair
Initialization filename
Cancel
OK



Section
Specifies a section of the .INI file.
Note: Omit the brackets. For example: fonts



Keyname
Specifies the key in a key/value pair. (The key is the portion to the left of the equal sign in the key/value 
pair.)



Value
Specifies the value in a key/value pair. (The value is the portion to the right of the equal sign in the 
key/value pair.)
Fill in this field only if you are adding a key/value pair.



Add key/value pair
Inserts the /A command option, causing the key/value pair to be added to the section.
If the key already exists, it is replaced.



Remove key/value pair
Inserts the /R command option, causing the key/value pair to be removed from the section.



List key/value pair
Inserts the /L command option, causing the key/value pair to be displayed on the workstation console.



Initialization filename
Inserts the /S: command option, specifying the .INI file to modify.



Cancel
Cancels the NNWIN INI command.



OK
Inserts the NNWIN INI command in the script.



Environment variable (NNEDT)
NNEDT adds or modifies an environment variable in a configuration file.

Regions and buttons
Variable name
Text/Value
Action
Input file
Cancel
OK



Variable name
The name of the environment variable to be added or modified.
Select a name from the drop down list or type one in.



Text/Value
The string to be appended to or removed from the environment variable.
Example:    c:\apps\xyz



Action
"Add Text" inserts the /A command option, causing the specified "Text/Value" to be appended to the 

environment variable.

"Delete Text" inserts the /R command option, causing the specified "Text/Value" to be deleted from 
the environment variable.

"Add Variable" causes the new environment variable (with the specified "Text/Value" string appended 
to it) to be inserted at the end of the specified "Input file."



Input file
The configuration file containing the environment variable.
Enter the path and file. If you omit the path, the current directory is assumed.



Cancel
Cancels the NNEDT command.



OK
Inserts the NNEDT command in the script.



Exit script (%EXIT)
%EXIT terminates script execution.

Regions and buttons
Return code
Retry script
Cancel
OK

Related topics
Admininstration Console



Return code
The code to be fed back to the Admininstration Console upon return from script execution. Enter the 
desired number.
Important: Use the code 9999 to indicate that the script has run for the last time. When this code is 
received, the script is set as processed in the client's NetWare Navigator transfer log.



Retry script
Inserts the NOPROC command option, enabling the script to be executed again later.



Cancel
Cancels the %EXIT command.



OK
Inserts the %EXIT command in the script.



Go to (%GOTO)
%GOTO causes script execution to unconditionally branch to a labelled point in the script.

Regions and buttons
Label
Cancel
OK



Label
The label to branch to.
Type in the desired label without the leading colon.
Example:    RenameFile



Cancel
Cancels the %GOTO command.



OK
Inserts the %GOTO command in the script.



Go to, if error (%ONERROR)
%ONERROR causes script execution to branch to a labelled point in the script if any errors occur before the 
next %ONERROR command is executed.

Regions and buttons
Go to label
Cancel
OK



Go to label
The label to branch to. Type in the desired label without the leading colon.
Example:    CopyFileError



Cancel
Cancels the %ONERROR command.



OK
Inserts the %ONERROR command in the script.



If condition true (%IF)
%IF checks the client's NetWare Navigator transfer log for an event and either continues or terminates 
script execution based on the results.

Regions and buttons
One
Any
Receive Type
File name
Start date
End date
Start time
End time
Reason code
Client
Cancel
OK



One
Inserts the ONE command option, specifying that script execution is to continue only if one instance of the 
event is found.
If multiple or no instances are found, execution terminates and the script is set as "not processed."



Any
Inserts the ANY command option, specifying that script execution is to continue if one or more instances 
of the event are found.
If one instance is found, the command returns zero.
If multiple instances are found, the command returns 91.
If no instances are found, script execution terminates and the script is set as "not processed."



Receive Type
"Received" inserts the RECV command option, specifying to check only for entries that log the file as 

received.

"Sent" inserts the SENT command option, specifying to check only for entries that log the file as sent.

"Errors" inserts the ERRORS command option, specifying to check only for entries that log the file as in
error.

"Queued" inserts the QUEUED command option, specifying to check only for entries that log the file as 
queued.

"Received processed" inserts the RECVPROC command option, specifying to check only for entries 
that log the file as received and processed.

"Send" inserts the SENDPROC command option, specifying to check only for entries that log the file as 
sent and processed.

"All" inserts the ALL command option, specifying to check all entries for the file.

"Session" inserts the SESSION command option, specifying to check only for entries that log the 
beginning and ending of transfer of the file.



File name
Inserts the FILE= command option, specifying to check only for entries containing the specified filename.



Start date
Inserts the SDATE= command option, specifying to check only for entries containing the specified start 
date.



End date
Inserts the EDATE= command option, specifying to check only for entries containing the specified end 
date.



Start time
Inserts the STIME= command option, specifying to check only for entries containing the specified start 
time.



End time
Inserts the ETIME= command option, specifying to check only for entries containing the specified end 
time.



Reason code
Inserts the RC= command option, specifying to check only for entries containing the specified return code.



Client
Inserts the USER= command option, specifying to check only for entries containing the specified user.



Cancel
Cancels the %IF command.



OK
Inserts the %IF command in the script.



If directory exists (NNCHK)
NNCHK checks for the existence of a directory.

Regions and buttons
Directory to find
Create directory if it does not exist
Do not display error messages
Cancel
OK



Directory to find
The directory to find. Enter a full path.



Create directory if it does not exist
Inserts the /C command option, causing the specified directory to be created if it doesn't exist.



Do not display error messages
Inserts the /Q command option, suppressing screen output from NNCHK.



Cancel
Cancels the NNCHK command.



OK
Inserts the NNCHK command in the script.



If file exists (%IF EXISTS)
%IF EXISTS checks for the existence of a file. If the file is found, the message <file> DOES EXIST 
AND WAS FOUND is written to the script log, and script execution continues.
Otherwise, the command returns a nonzero code; the message <file> DOES NOT EXIST is written to 
the script log; and script execution terminates without a return code.
Important: If you use a %ONERROR command with this command and %IF EXISTS returns a nonzero 
value, script execution branches to the label specified in the %ON ERROR command.

Regions and buttons
Input field
File in NetWare Navigator Receive Path
Cancel
OK

Related topics
Receive path



Input field
Enter the name of the file to find, including the full path.
Example:    c:\dos\edit.com
If you omit the path, the current directory is assumed.



File in NetWare Navigator Receive Path
Causes the receive path to prefix the specified path and filename. The current directory is not assumed in
this case.



Cancel
Cancels the %IF EXISTS command.



OK
Inserts the %IF EXISTS command in the script.



Keystroke playback (SCHEDRUN)
Playing back a keystroke file is the only SCHEDRUN option supported by this dialog.
A sample DOS keystroke file is available in SYS:NETNAV\PACKAGES on the Distribution Server.
Note: To play back Windows keystrokes, use the Schedule edit (WIN) command.

Regions and buttons
Keystroke file
Cancel
OK

Related topics
Using keystroke files



Keystroke file
The keystroke (.KSF) file to play back.
Do not include the .KSF extension in the filename.



Cancel
Cancels the SCHEDRUN command.



OK
Inserts the SCHEDRUN command in the script.



Label
A label provides a point in the script to which execution can branch.

Regions and buttons
Input field
Cancel
OK



Input field
Type the desired label without the leading colon.
Example:    CopyFileError



Cancel
Cancels the Label command.



OK
Inserts the label in the script.



Locate path of file (%LPATH)
%LPATH searches outside the receive path for a file and sets the %LPATH variable to the path where the 
file is located.
If the file isn't found or if multiple copies of the file are found, script execution terminates without a return 
code, unless a %ONERROR command causes execution to branch to an appropriate exit routine.
If the syntax of your command is incorrect, the script is terminated and set as processed.

Regions and buttons
Input field
Cancel
OK



Input field
Enter the name and extension of the file to locate.
Example:    xyz.com



Cancel
Cancels the %LPATH command.



OK
Inserts the %LPATH command in the script.



Log message (%LOGMSG)
%LOGMSG writes a message to both the script log and the SATELITE.LOG.

Regions and buttons
Input field
Cancel
OK



Input field
Enter the text of your message exactly as it is to appear in the script log.
Example:    Error verifying workstation conditions



Cancel
Cancels the %LOGMSG command.



OK
Inserts the %LOGMSG command in the script.



Occurrences of file (NNLOC)
NNLOC locates one or more files.

Regions and buttons
File to locate
Place results in file
Append results
Exclude this path from search
Drives to search
Cancel
OK



File to locate
The name and extension of the files to locate.
Use wildcard characters as needed.



Place results in file
Inserts the /F command option, causing NNLOC output (the located path) to be redirected to the specified 
disk file.
Enter a full path and filename. If you omit the path, the current directory is assumed. If the file exists, it is 
overwritten unless you select "Append results."



Append results
Inserts the /A command option, causing output from NNLOC to be appended to the specified file.



Exclude this path from search
Inserts the /X command option, causing the specified directory to be excluded from the search.
Enter the full path and directory name, followed by a backslash.
Example:    c:\netnav\recv\
If you omit the path, the current directory is assumed.
Note: Subdirectories of the specified directory are not excluded from the search.



Drives to search
Inserts the /D command option, causing the selected drives to be searched.
If you don't select any drives, only the current drive is searched.



Cancel
Cancels the NNLOC command.



OK
Inserts the NNLOC command in the script.



Rename files (NNREN)
NNREN renames one or more files.

Regions and buttons
Current file name
New file name
Cancel
OK



Current file name
The path and filename of the file to be renamed.
If you omit the path, the current directory is assumed.



New file name
The new path and filename.
If you omit the path, the current directory is assumed.



Cancel
Cancels the NNREN command.



OK
Inserts the NNREN command in the script.



Schedule edit (SCHEDSET)
SCHEDSET adds, modifies, or deletes a scheduled event. (An event is the playing back of a keystroke 
file.)

Regions and buttons
Add/modify event
Delete event
Keystroke file
Date
Time
Frequency
Days of the week
Event number
Cancel
OK

Related topics
Using keystroke files



Add/modify event
Inserts the S command option, causing either a new event to be scheduled (if the specified "Keystroke 
file" doesn't exist) or an existing event to be modified.



Delete event
Inserts the C command option, causing the specified "Keystroke file" event to be deleted from the 
schedule.



Keystroke file
Inserts the K= command option, specifying the keystroke (.KSF) file to play back.
You need not include the .KSF extension in the filename.



Date
Inserts the D= command option, specifying the earliest date (MM/DD/YY) the event can occur.
If you don't fill in this field, 01/01/90 is assumed.



Time
Inserts the T= command option, specifying in 24-hour (HH:MM) format the earliest time the event can 
occur.
If you select "Time interval," type a plus sign (+) in the hour field and a number in the minutes field. This 
causes the event to recur at the specified interval, starting at 00:00 (12:00 a.m.).
If you do not fill in this field, 00:00 is assumed.



Frequency
"Once" inserts the R=O command option, causing the event to occur only once (on the specified 

"Date" and "Time").
Note: If the "Date" and "Time" are past, the event will never occur.

"Daily" inserts the R=D command option, causing the event to occur regularly on the specified "Days 
of the week" at the specified "Time," starting on or after the specified "Date."

"Weekly" inserts the R=W command option, causing the event to occur weekly on the specified "Days 
of the week" at the specified "Time," starting on or after the specified "Date." (Only one day can 
be selected for "Days of the week.")

"Monthly" inserts the R=M command option, causing the event to occur monthly on the specified 
"Date" and "Time."



Days of the week
Lets you qualify a "Daily" or "Weekly" schedule.
Seven characters are appended to the R=D or R=W command option representing the seven days of the 
week. Selected days use a Y character; unselected days use an N character.



Event number
Inserts the N= command option for add/modify requests.
Select the number that identifies the event in the event list. Valid values are 1 through 8.



Cancel
Cancels the SCHEDSET command.



OK
Inserts the SCHEDSET command in the script.



Schedule edit (NNWIN SCHED)
NNWIN SCHED adds, modifies, or deletes a scheduled event. (An event is the execution of a file, such as 
an .EXE or .BAT file.)
Note: You can run the MS Windows Recorder as a scheduled event to play back a keystroke file.

Regions and buttons
Name
Add
Modify
Remove
Description
Command
Parameters
Frequency
Redirect output to log
Day(s) of the week
Time
Time interval
Retry time limit
Application type
Window type
State
Date
Cancel
OK

Related topics
Using keystroke files



Name
The name of the event to add, modify, or delete.



Add
Inserts the ADD command option, causing the new event to be added to the list of scheduled events.



Modify
Inserts the MODIFY command option, causing the schedule for the event to be modified.



Remove
Inserts the REMOVE command option, causing the event to be deleted from the list of scheduled events.
If you select this option, you need only fill in the "Name" field.



Description
Inserts the DESCRIPTION= command option, providing a short description of the event.



Command
Inserts the COMMAND= command option, specifying the command to execute for the event.
Unless the path to the command is in your DOS search path, you must specify a path for the command. If
you omit the path, the current directory is searched followed by the DOS search path.
Example:    To run a keystroke file that was created with the MS Windows Recorder, you would type in the following:
recorder.exe



Parameters
Inserts the PARAM= command option, specifying any parameters to the specified "Command."
Example:    To run a keystroke file named KEYSTRKS.REC that was created with the MS Windows Recorder, you would type in the 
following:
-h keystrks.rec



Frequency
"Once" is the default event type, and specifies that the event will occur only once, on the specified 

"Date" and "Time."
Note: If the "Date" and "Time" are past, the event will never occur.

"Timed" inserts the TYPE=TIMED command option, causing the event to occur first on the specified 
"Date" and "Time," and thereafter at the specified "Time interval."

"Daily" inserts the TYPE=DAILY command option, causing the event to occur daily at the specified 
"Time," starting on the specified "Date."

"Weekly" inserts the TYPE=WEEKLY command option, causing the event to occur weekly on the 
specified "Day(s) of the week" at the specified "Time," starting on or after the specified "Date."

"Monthly" inserts the TYPE=MONTHL command option, causing the event to occur monthly on the 
specified "Date" and "Time."



Redirect output to log
Inserts the REDIRECT=ON command option, causing screen output from the event to be redirected to the 
client's NetWare Navigator event log.



Day(s) of the week
Inserts the DAYS= command option, allowing you to qualify a "Weekly" schedule.
For each day you select, an abbreviation for that day is appended to the DAYS= command option.



Time
Inserts the TOD= command option, specifying in 24-hour format (HH:MM) the earliest time the event can 
occur.
If you do not fill in this field, 00:00 (12:00 a.m.) is assumed.



Time interval
Inserts the INTERVAL= command option, causing the event to recur at the specified time interval 
(HH:MM), starting on the specified "Date" and "Time."



Retry time limit
Inserts the LIMIT= command option, causing execution of the event to be retried for the specified 
amount of time (HH:MM) if initially unsuccessful.



Application type
Lets you indicate the type of application the specified "Command" is.

"Windows application" is the default. It specifies a Windows application.

"PIF" inserts the APPLIC=PIF command option, specifying a .PIF file.

".EXE/.COM/batch" inserts the APPLIC=EXE command option, specifying an .EXE, .COM, or .BAT 
file.

"DOS Command" inserts the APPLIC=DOS command option, specifying a DOS command.



Window type
Lets you specify the type of window the specified "Command" runs in.

"Invisible" is the default. It specifies an invisible window.

"Normal" inserts the WINDOW=NORMAL command option, specifying the application will run in its 
default display mode.

"Minimized" inserts the WINDOW=MIN command option, specifying a minimized window (icon).

"Maximized" inserts the WINDOW=MAX command option, specifying a maximized window.



State
"Active" is the default state, meaning the event is turned on (will occur as scheduled).

"Inactive" inserts the STATE=INACTIVE command option, meaning the event is turned off (will not 
occur even though it is scheduled).



Date
Inserts the DATE= command option, specifying the earliest date the event can occur.
If you don't fill in this field, 01/01/90 is assumed.



Cancel
Cancels the NNWIN SCHED command.



OK
Inserts the NNWIN SCHED command in the script.



Schedule reload (SCHEDRUN)
SCHEDRUN reloads the event schedule, causing schedule modifications made since the last loading of the
schedule to take effect.



Set file status (%SETPROC)
%SETPROC sets entries in the client's NetWare Navigator transfer log as processed. This dialog always 
inserts the RECV command option, making it so you can set as processed only entries that log files as 
received.

Regions and buttons
File name
Start date
End date
Start time
End time
Reason Code
Client
Cancel
OK



File name
Inserts the FILE= command option, causing only entries containing the specified filename to be set as 
processed.



Start date
Inserts the SDATE= command option, causing only entries containing the specified start date to be set as 
processed.



End date
Inserts the EDATE= command option, causing only entries containing the specified end date to be set as 
processed.



Start time
Inserts the STIME= command option, causing only entries containing the specified start time to be set as 
processed.



End time
Inserts the ETIME= command option, causing only entries containing the specified end time to be set as 
processed.



Reason code
Inserts the RC= command option, causing only entries containing the specified return code to be set as 
processed.



Client
Inserts the USER= command option, causing only entries containing the specified user name to be set as 
processed.



Cancel
Cancels the %SETPROC command.



OK
Inserts the %SETPROC command in the script.



Start script (%GODATE)
%GODATE lets you delay script execution until a future date.

Regions and buttons
Start script on
Cancel
OK



Start script on
The earliest date (MM/DD/YY) script execution is to start.
The system date is compared with this date. If the system date is earlier, script execution terminates 
without a return code.
Important: If you use the %ONERROR command with this command and the system date compares 
earlier than the start date, script execution branches to the label specified in the %ONERROR command.



Cancel
Cancels the %GODATE command.



OK
Inserts the %GODATE command in the script.



Warning window (NNWIN WARN)
NNWIN WARN causes a warning dialog to be displayed on the client workstation. The dialog lets the user 
do one of the following:
- Proceed with script execution immediately.
- Pause script execution for a specified time.
- Cancel further script execution.
Unless the user chooses to cancel script execution, NNWIN WARN completes with a zero return code.

Regions and buttons
Message to be displayed
Time to delay
Cancel
OK



Message to be displayed
Inserts the MSG= command option, specifying the message to be displayed in the warning dialog.



Time to delay
Inserts the TIME= command option, specifying the number of minutes script execution will be suspended 
if the user chooses "Pause" in the warning dialog.
Or, if no input is received in the warning dialog for the specified number of minutes, script execution will 
continue.



Cancel
Cancels the NNWIN WARN command.



OK
Inserts the NNWIN WARN command in the script.



OS/2 Script Commands
For detailed information on the command line format and return codes for these commands, see 
Appendix A of the NetWare Navigator Administration Guide.

Backup/update file
Comments
Disk space
Edit group/icon
Edit .INI
Environment variable
If directory exists
Keystroke playback
Locate path of file
Occurrences of file
OS/2 commands
PM window - active
PM window - close
Reboot
Schedule edit
Script pause
Script return code
Set file status
Start script



Backup/update file (NNUPDATE)
NNUPDATE replaces a file (typically an application) with a new version of the file, backing up the old 
version in the process.

Regions and buttons
Extension of file to be updated
Extension of new file
Extension of saved file
Full pathname of file to update
Application parameters
Start the application
Cancel
OK



Extension of file to be updated
Inserts the /E= command option, specifying the extension of the file that is to be replaced.
If you don't fill in this field, ".EXE" is assumed.



Extension of new file
Inserts the /N= command option, specifying the extension of the file that is to replace the old file.
If you don't fill in this field, ".NEW" is assumed.



Extension of saved file
Inserts the /O= command option, specifying the extension under which to save the old file.
If you don't fill in this field, ".OLD" is assumed.



Full pathname of file to update
The full path and filename of the file to be replaced.
If you omit the path, the current directory is assumed.



Application parameters
The parameters to the application, if any.



Start the application
Causes the application file to be executed as soon as the replacement and backup are done.



Cancel
Cancels the NNUPDATE command.



OK
Inserts the NNUPDATE command in the script.



Comments (REM)
REM comments make your script more readable but are ignored during script execution.

Regions and buttons
Input field
Cancel
OK



Input field
Enter the text of your comment.



Cancel
Cancels the comment.



OK
Inserts the comment in the script.



Disk space (NNSPACE)
NNSAPCE displays the amount of free and used space on the disk containing the receive path. It performs 
other optional checking based on any input you provide in the dialog.

Regions and buttons
Calculate space used by this file
Directory path
Check for this amount of disk space
Do not display error messages
Cancel
OK



Calculate space used by this file
Inserts the /F command option, causing the amount of space occupied by the specified files to be 
displayed.
Use a full path and wildcard characters as needed. If you omit the path, the current directory is assumed.



Directory path
The directory path on which to perform the actions selected below. If you omit the path, the current 
directory is assumed.

"Calculate space used by this directory" inserts the /D command option, causing the amount of space
occupied by the specified directory to be displayed.

"Calculate space used by all subdirectories of this directory" inserts the /S command option, causing 
the amount of space occupied by all subdirectories of the specified directory to be displayed.



Check for this amount of disk space
Causes the specified amount of disk space to be verified.
Enter the desired amount and select kilobytes (K) or megabytes (M) from the drop down list.
Important: When you use this option, NNSPACE returns a nonzero completion code if the specified 
amount of space is not available.



Do not display error messages
Inserts the /Q command option, suppressing screen output from NNSPACE.



Cancel
Cancels the NNSPACE command.



OK
Inserts the NNSPACE command in the script.



Edit group/icon (NNICON)
NNICON adds or removes an application icon.

Regions and buttons
Application
Icon name
Group name
Add icon
Remove icon
Application type
Close window on exit
Run full screen
Do not display error messages
Cancel
OK



Application
"Full path name" specifies the full path and filename of the application executable file.

"Parameters" specifies any parameters to the application.

"Working directory" specifies the working directory for the application.

"Initial position" inserts the /I command option, specifying the initial position of the application 
window in absolute screen coordinates (x,y).

"Initial size" specifies the initial width and height of the application window in pixels (w,h). The 
specification is appended to the /I command option.



Icon name
The name of the application icon.



Group name
The name of the group containing the icon.
If the group doesn't exist, it is created.



Add icon
Inserts the /A command option, causing the icon to be added to the group.



Remove icon
Inserts the /R command option, causing the icon to be removed from the group.



Application type
Lets you indicate the type of application being added.

"DOS command" inserts the /D command option, indicating the application is a DOS command.

"OS/2 Presentation Manager" inserts the /P command option, indicating the application is a 
Presentation Manager application.

"OS/2 window" inserts the /W command option, indicating the application can run in an OS/2 window.



Close window on exit
Inserts the /C command option, causing the application window to close when the application terminates.



Run full screen
Inserts the /F command option, causing the application to run in an OS/2 full screen.



Do not display error messages
Inserts the /Q command option, causing screen output from NNICON to be suppressed.



Cancel
Cancels the NNICON command.



OK
Inserts the NNICON command in the script.



Edit .INI (NNINI)
NNINI modifies an .INI file.

Regions and buttons
Section
Key name
Value
Add key/value pair
Remove key/value pair
Export key/value pairs to file
Import key/value pairs from file
List key/value pairs
Display binary data
Input file
Output file
Cancel
OK



Section
The target section of the INI file.



Key name
The target key name in the specified section.



Value
The value assigned to the specified key.



Add key/value pair
Inserts the /A command option, causing the specified key/value pair to be added to the specified section.



Remove key/value pair
Inserts the /R command option, causing the specified key/value pair to be removed from the specified 
section.
If no key is specified, the specified section is removed from the INI file.



Export key/value pairs to file
Inserts the /E command option, causing the specified section of the "Input file" to be exported to the 
"Output file."



Import key/value pairs from file
Inserts the /I command option, causing the specified section to to be imported from the "Input file" to the 
"Output file."



List key/value pairs
Inserts the /L command option, causing the specfied key/value pair to be displayed.
If no key is specified, all key/value pairs in the specified section are displayed.
if no section is specified, the contents of the entire .INI file are displayed.



Display binary data
Appends the [a] option to the /L command option, causing a binary dump of the whole .INI file to be 
displayed rather than just the first 256 bytes, which is the default.
This option applies only if "List key/value pairs" is selected; it is otherwise grayed.



Input file
Inserts the /S: command option, specifying the full path and filename of the .INI file that is to serve as 
input to the specified modifications.



Output file
Inserts the /D: command option, specifying the full path and filename of the .INI file that is to serve as 
output from the specified modifications.



Cancel
Cancels the NNINI command.



OK
Inserts the NNINI command in the script.



Environment variable (NNEPATH)
NNEPATH adds or modifies an environment variable in a configuration file.

Regions and buttons
Variable name
Text/Value
Action
Input file
Output file
Cancel
OK



Variable name
The name of the environment variable to add or modify.
Select a name from the drop down list or type one in.



Text/Value
The string to append to or remove from the environment variable.
Example:    c:\apps\xyz



Action
"Add Text" inserts the /A command option, causing the specified "Text/Value" to be appended to the 

environment variable.

"Delete Text" inserts the /R command option, causing the specified "Text/Value" to be deleted from 
the environment variable.

"Add Variable" inserts the /S command option, causing the new environment variable (with the 
specified "Text/Value" string appended to it) to be inserted at the end of the specified "Output file."



Input file
The full path and filename of the configuration file that is to serve as input to the specified modifications.



Output file
The full path and filename of the configuration file that is to serve as output from the specified 
modifications.



Cancel
Cancels the NNEPATH command.



OK
Inserts the NNEPATH command in the script.



If directory exists (NNCHKDIR)
NNCHKDIR checks for the existence of a directory.

Regions and buttons
Directory to find
Create directory if it does not exist
Do not display error messages
Cancel
OK



Directory to find
The directory you want to find.
Enter a full path. If you omit the path, the current directory is assumed.



Create directory if it does not exist
Inserts the /C command option, causing the specified directory to be created if it doesn't exist.



Do not display error messages
Inserts the /Q command option, suppressing screen output from NNCHKDIR.



Cancel
Cancels the NNCHKDIR command.



OK
Inserts the NNCHKDIR command in the script.



Keystroke playback (KEYMAN)
KEYMAN plays back a keystroke file.

Regions and buttons
Keystroke file
Title of application to receive keystrokes
Set variables used by keystroke file
Ignore missing application
Cancel
OK

Related topics
Using keystroke files



Keystroke file
The name of the keystroke file to play back.



Title of application to receive keystrokes
The name of the application to which the keystroke file supplies input (for example, an installation 
program).



Set variables used by keystroke file
Inserts up to ten /V command options, which assign values to variables in the keystroke file.
Fill in as many fields as desired, each with an assignment statement.
Example:    dirname=apps



Ignore missing application
Inserts the /Q command option, indicating that the application to which the keystroke file supplies input 
need not be an active task within OS/2 since the keystroke file itself will start the application.



Cancel
Cancels the KEYMAN command.



OK
Inserts the KEYMAN command in the script.



Locate path of file (NNPATH)
NNPATH searches for one or more files and sets the %LPATH% variable to the paths where the files are 
located.

Regions and buttons
File to locate
Exclude this path from search
Create a command file
REXX commands
Place results in file
Append results
Drives
Cancel
OK



File to locate
The filename and extension of the files to locate. Use wildcard characters as needed.



Exclude this path from search
Inserts the /X command option, causing the specified directory and its subdirectories to be excluded 
from the search.
Enter the full path and directory name. If you omit the path, the current directory is assumed.



Create a command file
Inserts the /C= command option, creating a command (.CMD) file of the specified name containing the 
following line:
SET LPATH=paths
where paths are the paths to any files found matching the specified "File to locate."



REXX commands
Inserts the /R command option, indicating that the specified command file is to be a REXX command file.



Place results in file
Inserts the /F command option, causing output from NNPATH (the located paths) to be written to the 
specified disk file rather than to the %LPATH% variable.
Enter a full path and filename. If you omit the path, the current directory is assumed. If the file exists, it is 
overwritten unless you select "Append results."



Append results
Inserts the /A command option, causing output from NNPATH to be appended to the specified file.



Drives
Inserts the /D command option, causing the selected drives to be searched.
If you don't select any drives, only the current drive is searched.



Cancel
Cancels the NNPATH command.



OK
Inserts the NNPATH command in the script.



Occurrences of file (NNLOCATE)
NNLOCATE locates one or more files.

Regions and buttons
File to locate
Exclude this path from search
Create a command file
REXX commands
Place results in file
Append results
Drives
Cancel
OK



File to locate
The filename and extension of the files to locate. Use wildcard characters as needed.



Exclude this path from search
Inserts the /X command option, causing the specified directory and its subdirectories to be excluded 
from the search.
Enter the full path and directory name. If you omit the path, the current directory is assumed.



Create a command file
Inserts the /C= command option, creating a command (.CMD) file of the specified name containing the 
following line:
SET LPATH=paths
where paths are the paths to any files found matching the specified "File to locate."



REXX commands
Inserts the /R command option, indicating that the specified command file is to be a REXX command file.



Place results in file
Inserts the /F command option, causing output from NNLOCATE (the located paths) to be redirected to the
specified disk file.
Enter a full path and filename. If you omit the path, the current directory is assumed. If the file exists, it is 
overwritten unless you select "Append results."



Append results
Inserts the /A command option, causing output from NNLOCATE to be appended to the specified file.



Drives
Inserts the /D command option, causing the selected drives to be searched.
If you don't select any drives, only the current drive is searched.



Cancel
Cancels the NNLOCATE command.



OK
Inserts the NNLOCATE command in the script.



OS/2 Commands
OS/2 commands perform various functions.
See your OS/2 Command Reference for details.

Regions and buttons
Input field
Cancel
OK



Input field
Enter the desired OS/2 command exactly as you would at an OS/2 command prompt.



Cancel
Cancels the OS/2 command.



OK
Inserts the OS/2 command in the script.



PM window - active (PMPOP)
PMPOP moves a window to the top of the OS/2 Window List, making it the active window.

Regions and buttons
Window title
Cancel
OK



Window title
The name of the window to be made active.



Cancel
Cancels the PMPOP command.



OK
Inserts the PMPOP command in the script.



PM window - close (PMSTOP)
PMSTOP closes a Presentation Manager application.
Important: If closing the application involves a dialog, use the Keystroke playback command instead of 
this command.

Regions and buttons
Window title
Window title is the application name
Close application without confirmation
Cancel
OK



Window title
The name of the window to be closed.



Window title is the application name
Inserts the /P command option, indicating that the window title is the same as the name of the application
that is to be closed.



Close application without confirmation
Inserts the /K command option, causing the application to be terminated without a CLOSE message 
being sent to the window.
This bypasses any closing dialog but may also lose unsaved work in the application.
Important: If you do not select this option, a CLOSE message is sent to the window, but the application 
might not close if the user has unsaved work.



Cancel
Cancels the PMSTOP command.



OK
Inserts the PMSTOP command in the script.



Reboot (REBOOT)
REBOOT causes the workstation to reboot as if <Ctl><Alt><Del> were pressed.



Schedule edit (SCHEDULE)
SCHEDULE adds, modifies, or deletes a scheduled event. (An event is the execution of a file, such as 
an .EXE or .CMD file.)

Regions and buttons
Name
Add
Modify
Remove
Description
Command
Parameters
Frequency
Use command processor
Redirect output to log
Days of the week
Time
Time interval
Retry time limit
Application type
Window type
State
Date
Cancel
OK



Name
The name of the event to add, modify, or delete.



Add
Inserts the ADD command option, causing the new event to be added to the list of scheduled events.



Modify
Inserts the MODIFY command option, causing the schedule for the event to be modified.



Remove
Inserts the REMOVE command option, causing the event to be deleted from the list of scheduled events.
If you select this option, you need only fill in the "Name" field.



Description
Inserts the DESCRIPTION= command option, providing a short description of the event.



Command
Inserts the COMMAND= command option, specifying the command to execute for the event.
Include the path to the command if it is not in your OS/2 search path. If you omit the path, the current 
directory is searched followed by the OS/2 search path.
Example:    c:\apps\xyzinst.exe



Parameters
Inserts the PARAM= command option, specifying any parameters to the specified "Command."



Frequency
"Once" is the default event type, and specifies that the event will occur only once, on the specified 

"Date" and "Time."
Note: If the "Date" and "Time" are past, the event will never occur.

"Timed" inserts the TYPE=TIMED command option, causing the event to occur first on the specified 
"Date" and "Time," and thereafter at the specified "Time interval."

"Daily" inserts the TYPE=DAILY command option, causing the event to occur daily at the specified 
"Time," starting on the specified "Date."

"Weekly" inserts the TYPE=WEEKLY command option, causing the event to occur weekly on the 
specified "Days of the week" at the specified "Time," starting on or after the specified "Date."

"Monthly" inserts the TYPE=MONTHL command option, causing the event to occur monthly on the 
specified "Date" and "Time."



Use command processor
Suppresses the CMD=OFF command option, causing the OS/2 command processor to process the 
specified "Command."



Redirect output to log
Inserts the REDIRECT=ON command option, causing screen output from the event to be redirected to the 
client's NetWare Navigator event log.



Days of the week
Inserts the DAYS= command option, allowing you to qualify a "Weekly" schedule.
For each day you select, an abbreviation for that day is appended to the DAYS= command option.



Time
Inserts the TOD= command option, specifying in 24-hour format (HH:MM) the earliest time the event can 
occur.
If you do not fill in this field, 00:00 (12:00 a.m.) is assumed.



Time interval
Inserts the INTERVAL= command option, causing the event to reoccur at the specified time interval 
(HH:MM), starting on the specified "Date" and "Time."



Retry time limit
Inserts the LIMIT= command option, causing execution of the event to be retried for the specified 
amount of time (HH:MM) if initially unsuccessful.



Application type
Lets you indicate the type of application the specified "Command" is.

"Default" uses whatever application type the specified "Command" is.

"OS/2 Full screen" inserts the APPLIC=FULL command option, specifying an OS/2 full screen 
application.

"OS/2 Window" inserts the APPLIC=WINDOW command option, specifying an application that runs in 
an OS/2 window.

"Presentation Manager" inserts the APPLIC=PM command option, specifying a Presentation Manager
application.



Window type
Lets you specify the type of window the specified "Command" runs in.

"Invisible" is the default. It specifies an invisible window.

"Normal" inserts the WINDOW=NORMAL command option, specifying the application will run in its 
default display mode.

"Minimized" inserts the WINDOW=MIN command option, specifying a minimized window (icon).

"Maximized" inserts the WINDOW=MAX command option, specifying a maximized window.



State
"Active" is the default state, meaning the event is turned on (will occur as scheduled).

"Inactive" inserts the STATE=INACTIVE command option, meaning the event is turned off (will not 
occur even though it is scheduled).



Date
Inserts the DATE= command option, specifying the earliest date the event can occur.
If you don't fill in this field, 01/01/90 is assumed.



Cancel
Cancels the SCHEDULE command.



OK
Inserts the SCHEDULE command in the script.



Script pause (NNWAIT)
NNWAIT pauses script execution for a specified time and displays a countdown of the remaining time.

Regions and buttons
Time to resume execution
Use specified time as an interval
Do not display time countdown
Cancel
OK



Time to resume execution
The 24-hour time (HH:MM:SS) when script execution is to resume.
Example:    13:30:00



Use specified time as an interval
Inserts a plus sign (+) before the time, causing it to be interpreted as the amount of time to wait.
If you select this option, you can omit the hours and/or minutes from the time.



Do not display time countdown
Inserts the /Q command option, causing the countdown display to be suppressed.



Cancel
Cancels the NNWAIT command.



OK
Inserts the NNWAIT command in the script.



Script return code (NNSETRC)
NNSETRC sets the script return code.
If you don't specifty a return code using this command, the script returns zero and will not be retried.

Regions and buttons
Value
Cancel
OK

Related topics
Administration Console



Value
The code to be fed back to the Administration Console upon return from script execution.
Enter the desired number. Unless you specify a nonzero value, the script will not be retried.
Important: Use the code 9999 to indicate that the script has run for the last time. When this code is 
received, the script will be set as "processed" in the client's NetWare Navigator transfer log.



Cancel
Cancels the NNSETRC command.



OK
Inserts the NNSETRC command in the script.



Set file status (NNSETLOG)
NNSETLOG sets entries in the client's NetWare Navigator transfer log as "processed." Only entries that log
files as "received" can be set.

Regions and buttons
File name
Start date
End date
Start time
End time
Reason Code
Client
Cancel
OK



File name
Inserts the FILE= command option, causing only entries containing the specified filename to be set as 
processed.



Start date
Inserts the SDATE= command option, causing only entries containing the specified start date to be set as 
processed.



End date
Inserts the EDATE= command option, causing only entries containing the specified end date to be set as 
processed.



Start time
Inserts the STIME= command option, causing only entries containing the specified start time to be set as 
processed.



End time
Inserts the ETIME= command option, causing only entries containing the specified end time to be set as 
processed.



Reason code
Inserts the RC= command option, causing only entries containing the specified return code to be set as 
processed.



Client
Inserts the USER= command option, causing only entries containing the specified user name to be set as 
processed.



Cancel
Cancels the NNSETLOG command.



OK
Inserts the NNSETLOG command in the script.



Start script (NNDATE)
NNDATE returns a nonzero value if the current date doesn't fall within a specified range of dates.
You can use the results of NNDATE as a condition for continuing script execution.

Regions and buttons
Earliest start date
Latest start date
Cancel
OK



Earliest start date
The beginning date (MM/DD/YY) in the range.



Latest start date
The ending date (MM/DD/YY) in the range.



Cancel
Cancels the NNDATE command.



OK
Inserts the NNDATE command in the script.



Glossary
active job
Administration Console
client
completed job
contents list
distribution job
distribution list
Distribution Server
keystroke file
package
problem job
pull
push
receive path
script
script log
Staging Server



active job
A scheduled distribution job that
- Hasn't started, or
- Has started and is still in progress.
Jobs become inactive when they reach completion or when they "time out" (don't return any feedback for 
a configured time period).
You can set the active job timeout using the NetWare Navigator Setup program.



Administration Console
The workstation program used to
- Create packages and submit them for distribution.
- Access feedback on distributions.
You can set up workstations to run the Administration Console using the NetWare Navigator Setup 
program. Only one workstation can run the program at a time.



client
A workstation running the NetWare Navigator Client software. A client
- Can receive and install a package without the user being present.
- Provides the user with utilities for downloading and installing packages and performing other related 

tasks.
You can set up clients using the NetWare Navigator Setup program.



completed job
A distribution job that fits one of the following descriptions:
- The package has a script and execution of the script either succeeded or failed (was retried for the 

maximum time) on each node in the distribution list.
- The package doesn't have a script, was scheduled as a "push" distribution, and was received on each

node in the distribution list.
- The package doesn't have a script, was scheduled as a "pull" distribution, and was received on each 

server in the distribution list.
- The distribution job was cancelled.



contents list
A list of the files in a package, not including the script file. For each file, the contents list specifies 
distribution source and destination information.



distribution job
A scheduled distribution of a package to the nodes in a distribution list. When you schedule a distribution 
job, the following process occurs:
1. The package is sent to the Distribution Server where it waits until the scheduled distribution time.
2. At the scheduled time, the package is distributed to each Staging Server named in the distribution list.
3. Once received at a Staging Server, the package is distributed to each of the Staging Server's clients 

that are named in the distribution list.
If you choose the "pull" distribution method when scheduling the job, this step is not performed until requested by users.

4. After the package is received at the client, the package script executes if the package has a script.
The user can delay script execution.



distribution list
A group of nodes (clients or Staging Servers) that forms a target for distributions.



Distribution Server
A NetWare server running the NetWare Navigator Distribution Server modules. The Distribution Server 
acts as the
- Starting point for all distributions.
- Collection point for all feedback from distributions.
The Distribution Server provides the link between the Administration Console and the Staging Servers.
You can set up the Distribution Server using the NetWare Navigator Setup program.



keystroke file
A file containing recorded keystrokes. A package script can play back a keystroke file as part of the 
package installation.
You can create keystroke files using the NetWare Navigator Client software.



package
A set of files to be distributed as a unit; for example, an application upgrade package. A package can 
include a script file that installs the package on client workstations.



problem job
A distribution job that encountered problems. The job can be
- Active (being retried), or
- Completed (retried the maximum time).
A job is no longer a problem job if it succeeds on a retry.



pull
A distribution method in which clients are notified of the availability of the package on the Staging Server, 
but must download the package themselves.
You select the distribution method ("pull" or "push") when you schedule the distribution job. The selected 
method applies to every client in the distribution list.



push
A distribution method in which Staging Servers automatically distribute the package to clients. The client 
cannot block the downloading of the package, but can delay script execution if the package has a script.
You select the distribution method ("pull" or "push") when you schedule the distribution job. The selected 
method applies to every client in the distribution list.



receive path
The path to which a file is distributed if you do not explicitly specify a target directory for the file.
On a Staging Server, the receive path is SYS:NETNAV\DISTRIB\RECV.
On a client, the default receive path is C:\NETNAV\RECV, but the user can change the receive path.



script
A command file that typically contains an installation procedure for a package. Unless delayed by the 
user, the script executes once the package is received at the client workstation.
A script is an optional part of a package.



script log
A file composed of messages logged by a script during its execution. The file is returned to the 
Distribution Server as job feedback.



Staging Server
A NetWare server running the NetWare Navigator Staging Server modules. Each Staging Server
- Can stage distributions to a specific set of clients.
- Returns distribution feedback to the Distribution Server.
A Staging Server provides the link between the Distribution Server and a specific set of clients.
You can set up Staging Servers using the NetWare Navigator Setup program.


